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0.0 Revision History 
-------------------------------------- 

V0.9 - 03/08/00 - Initial Release! Expect typos or grammar problems from it. 

V1.0 - 03/14/00 - Fixed any apparent typos and missing bits. 
                - Polished up some sentences and areas. 
                - Added description for the Little effect. 
                - Corrected Game Shark code. 

Coming Soon: 

    -more detailed music listings. 
    -more secrets and hidden things. 
    -whatever might be left out. 

1.0 General Description 
-------------------------------------- 

    Dance Dance Revolution has grown to become my favorite series in Konami's  
entire "Bemani" line of musical games. This genre of Konami games started with  
"Beatmania" and grew to contain "DDR," as well as "Pop 'n Music" and realistic  
games for the Guitar, Drums, and Keyboards. However, this series holds a special  
place in my heart. Not only does it have the most recognizable and catchy music  
(especially for an English-speaking audience) but it also has an amazing ability  
to combine the worlds of video-gaming and dancing into one incredible genre.  
This game has music and visuals to keep you entertained forever, but it is the  
true interactive nature of the game that makes it so fun. 

    The basic gameplay is simple to learn, but insanely tough to master. The  



game is played with four primary buttons, one being for each direction on a  
control pad (up, down, left, and right). On your side of the game screen, you  
will see these four directions indicated at the top section. During gameplay,  
flashing arrows will move slowly from the bottom of that "column" up to the top  
where your arrows are. The basic premise is to hit the correct direction's  
button whenever the flashing arrows meet with the arrows at the top. You hafta  
listen to the rhythm of the song as well, because the simple "sight" of the  
arrows can't always tell you exactly when to hit the arrows. You have a "dance  
meter" which increases as you do well and decreases as you miss. If it empties,  
you lose. 

    Each time you press a directional button, the game will keep track of how  
close to the exact beat you were. You can "Miss" or get a "Boo" if you do it  
poorly. A "Good" means you did it fairly well, while a "Great" or "Perfect" is  
right on the money. Each of these five possibilities yields more points than the  
one before it. Also, the game keeps track of a "combo" for you. A combo is how  
many "greats" or "perfects" you have gotten in a row. If you get a "good" or  
worse for any arrow... the combo ends. You receive a score at the end of the  
level, depending on how well you did (from "E" to "A" and then to "S." You get  
an "SS" if you did a combo for the entire level, from start to finish). It takes  
coordination as well as a sense of rhythm to play this game well, especially for  
the later levels. This also gives an incentive to play again, to earn an "SS" on  
every level variant. 

    This aspect alone makes the game incredibly fun to play with a standard  
control pad. However, this is not the true nature of the game. If you purchase  
the special Dance Dance Revolution Controller from Konami, you can experience  
the Arcade game's true play style (the one that proves to combine the gaming  
world with the world of dance). With this "dance mat" set up, you use your feet  
and dancing skill to play the game. The dance mat (as with the arcade machine)  
has four large arrows on it (set up like a giant version of the directional pad  
you're used to). With this, you must "step" to the beat properly, and this adds  
much more challenge and appeal to the game. In fact, only those with true  
dancing skills and coordination have ever been able to beat the toughest levels  
with the dance mat. 

    Songs that you play in DDR are amazingly catchy and well done. Aside from  
the "Konami Original" songs that you'll find in the game, all the songs that you  
play are taken from the "Dancemania" compilation series in Japan. This series of  
mix-CD's is released by Toshiba-EMI in Japan, and is composed of dance hits from  
around the world (mainly Europe). And, aside from the specialty DDR games, all  
of the songs in Dance Dance Revolution are in full English. So yes, every song  
that you hear in this game is from a REAL artist or group that has released  
their own CD in the past. Names like Chumbawamba, Olivia Newton John, EPMD, The  
Specials, Me&My, Captain Jack, and many others are well-known in America and  
worldwide.

    Either way, this game is truly one of the most well-conceived titles to come  
out of the gaming industry. When you get into it, it becomes very addictive.  
There are different dancers that you can choose to play on-screen, and songs  
that will easily make you want to go out and buy the artists' full CD's (because  
the songs are so great) ^_^ And besides, the game is universally appealing and  
simple enough for anyone to wanna try. Men, women, kids, adults... all of them  
will like the songs and the ability to "show off their moves" on the miniature  
dance floor. It is truly a series in which the term "video game" barely seems  
acceptable. I'd rather say "interactive experience." But even then, descriptions  
can't do the game justice. Give it a try, it's all I can say. 

    NOTE: To play an import game on an American Playstation, you normally need a  



"mod chip" to get your system to play the Japanese title. However, some recent  
import games like Final Fantasy VIII and Um Jammer Lammy will NOT work on an  
American Playstation with a normal mod chip. To play this, you have two choices.  
The first is to get the new type of mod chip that works with these locked-out  
games. Your second choice is if you have a Game Shark accessory for your PSX. If  
you have an older mod chip, you can get it to work with Dance Dance Revolution  
2nd Remix by using the following Game Shark code on the game: 

        D00200A6  1040 
        800200A6  1000 
        D0020D64  FFF2 
        80020D64  0001 
        D01C1BE4  FFF2 
        801C1BE4  0001 
        D01C1C7A  0C07 
        801C1C7A  3002 
        D01C2936  1040 
        801C2936  1000 

    This code must be on when the game boots up, until the "Konami" screen.  
After this point, you can turn the effects switch off, though this code will not  
mess up your game in any way. If you are unfamiliar with a Game Shark and how to  
use it, you can visit the maker, InterAct (www.gameshark.com) or the official- 
unnoficial best code site, the GSCCC (www.cmgsccc.com). 

2.0 Options Menu 
-------------------------------------- 

    The Options Menu in Dance Dance Revolution is completely in English, and  
therefore it should be self-explanatory in most any case. However, certain  
options may be earned through fulfilling certain objectives or might be  
difficult to understand. Various options will change the way that the gameplay  
operates, while others will be cosmetic changes. Any option choices that show up  
in a shade of Green are the "default" setting, while any other choices will show  
up in White just like the options themselves. The full set of menu options is as  
follows: 

    -Sound: Stereo/Monaural 

    -Vibration: Button/Miss/No Use 
        -Double Play: On/Off 

    -Key Config 
        -Double Mode Setting 
            -Type: A-D 
            -Type: I-III 
            -Exit 
        -Dance Play Setting 
            -Controller 1: On/Off 
            -Controller 2: On/Off 
            -Exit 

    -Memory Card 
        -Save 
            -Want to Save: Yes/No 
            -Overwrite Old Data: Yes/No 
        -Load 
            -Want to Load: Yes/No 



        -Auto Save: On/Off 
        -Edit Play: On/Off 
        -User Support 
            -Want to Continue: Yes/No 
        -Exit 

    -Game Level: 1-8 

    -Max Stage 
        -Easy: 1-5 
        -Normal: 1-5 
        -Hard: 1-5 
        -Non Stop: 2-5 

    -Time Limit: On/Off 

    -Game Over: Arcade/2ndReMIX 

    -BG Effect: On/Off 

    -Ending: Arcade/2ndReMIX/Off 

    -Character: Model 1/Model 2/Model 3/Model 4 

    -Exit 

    The "User Support" option in the "Memory Card" area has a special function,  
and must be explained. If you choose this, the game will search the current  
memory card for data from the first Dance Dance Revolution game for Playstation.  
If it finds it, it will ask you to continue. What this does, is add some data to  
the first DDR's save data. It will unlock any of the "secret songs" or "effects"  
that you have not released on that game so far. It will also give you access to  
the game's "Edit" mode. Additionally, it will give you access to the "Secret  
Stage Mode." Using this option saves a lot of time, as earning all these  
features on the first DDR (the legit way) takes far too long... and Konami  
obviously knew this. 

3.0 Arcade Mode 
-------------------------------------- 

    This is the primary mode of the game, and it's the place where you will  
spend most of your time. To choose the "Play Option" (how many players will play  
the game) you must hold down the "X" button while you press a button to select  
Arcade mode at the title screen's main menu. You then must choose the game's  
"difficulty" (which really just determines which set of levels you will play).  
You can also choose which "variant" of the levels you will play. And finally,  
you can decide which "effects" you want to take place on the level. The variant  
can be chosen on the difficulty screen. Press the "down" button twice to change  
Basic to Another. Press it twice again to move to Maniac (the variant level will  
be indicated on the bottom of the screen). In this game, however, you must input  
a few codes in order to choose the effects you want (see the tricks section).  
After doing so, you can choose the effects that you wish to use by pressing the  
"select" button at the screen where you choose the stage to play. This takes you  
to the "Effects Menu" where you input the codes and exit the menu in here by  
pressing "start." This menu also lets you change the variant at any point before  
you choose a stage (and better yet, when playing a 2-player game, both people  
can choose different sets of variants and effects for themselves). 



    -Play Option: Four choices "Single," "Couple," "Versus," or "Double." Single  
mode is the standard one-player game. Couple mode lets two players join the  
game, but they are working together to beat levels and set high scores. Versus  
mode is where the two players compete to earn the highest score (and become  
winner through that). Double mode is described below, and has two difficulties  
on which it can be played (rather than three, as there is no Double Maniac). 

    -Difficulty: Three choices "Easy," "Normal," or "Hard." Normal mode has the  
first set of the game's levels, while Hard mode has the other half of the levels  
(the tougher ones). You play a set of Three stages in whichever you choose, and  
you choose which song you will play for each new stage. All of the game's  
songs/levels are found within these two main modes. If you choose Easy mode, you  
will play One stage (chosen from an assortment of levels from both Normal and  
Hard). On Easy mode, you can not lose the stage, no matter how low your dance  
meter goes. Easy mode is just for practice, and does not let you set records or  
progress farther. 

    -Variant: Five choices "Basic," "Another," "Maniac," "Double Basic," or  
"Double Another." Basic is the default set of steps (arrows) for a level. This  
is the easiest choice of the bunch. Another is a bit harder and has more steps  
in it. Maniac is the hardest and has the most steps of all. Think of those as  
the easy, medium, and hard variants of each level. Double mode lets one person  
play with both controllers (yes, so they have to do double duty, worrying about  
eight arrows). Another Double is the harder version of Double, with more steps  
in the song. The last two variants are available with the "Double" Play Option,  
while the first three are used for "Single," "Couple," or "Versus" modes. 

    -Effects: Six choices "Little," "Left," "Right," "Mirror," "Shuffle," or  
"Hidden." Little mode and Hidden mode are separate and can be turned "On or  
Off." The other four options fall under the category of "Turn" and you can only  
have one of them on at a time (selected from the same part of the menu. Or, Turn  
can be set to "Off"). For all of the Turn choices, this will change the  
directions of all the "steps" (flashing arrows that come from the bottom) in the  
level. The gameplay remains unchannged. In Mirror mode, the steps in the level  
will be reversed to their opposite. In other words, for the arrows, left and  
right get switched, and up and down will get reversed as well. Left mode will  
rotate the position of the arrows 90 Degrees counter-clockwise (for the arrows,  
left becomes down, down becomes right, up becomes left, and right becomes up).  
Right mode will rotate the position of the arrows 90 Degrees clockwise (for the  
arrows, left becomes up, down becomes left, up becomes right, and right becomes  
down). Shuffle mode will randomly change all the steps in the level to a  
different direction. Little mode eliminates any steps that make a half-beat or  
smaller (in other words, the level will only have single-beat steps and  
therefore be much easier. However, this also obviously lowers the maximum score  
that you can get). Hidden mode will cause the arrows to slowly disappear once  
they reach the top half of the screen (so you must follow the lower part, as  
well as the beat, to stay alive). Also, as a note, neither the Left, Right, or  
Shuffle modes can be used with "Double." 

    Important info. Each song in the game has a difficulty level associated with  
it, and each song has a different difficulty for each of its variants. You can  
see the difficulty level below each song disc that you can select. The  
difficulty level itself is indicated by how many "feet" markers you will see, as  
well as a title (each level of difficulty has a title that indicates how tough  
it is). These difficulty levels are in relation to the other levels in the  
particular game. A specific level's difficulty number can always change if it  
appears again in a later DDR game. These difficulty titles are listed in the  
table below, along with how many "footmarks" each represents... 



    Also, there is the list of each step rank you can get while playing the game  
(along with the colors that represent them). This comes into play during the  
level, to tell how close you were to hitting a step (arrow) at the correct time.  
They are listed in order from best to worst. "Perfect" is right on the beat, and  
"Great" is extremely close. "Good" is close to the beat, and "Boo" is far off.  
"Miss" is what you get when you totally miss the beat or just don't even input  
anything at all for it. Your "combo" is counting how many Perfects or Greats you  
can get in a row. Your "Grade" at the end of the level depends on how well you  
did with the steps. If you keep a combo going for every beat of the stage (start  
to finish) you will receive an "SS" rank. Here are the tables of important info: 

        Song Difficulty          Step Rank                Level Grade 

        1: Simple                Perfect :  Yellow        E: Terrible 
        2: Moderate              Great   :  Green         D: Poor 
        3: Ordinary              Good    :  Blue          C: Fair 
        4: Superior              Boo     :  Pink          B: Good 
        5: Marvelous             Miss    :  Red           A: Great 
        6: Genuine                                        S: Perfect 
        7: Paramount                                     SS: Flawless 
        8: Exorbitant 

4.0 Song List and Info 
-------------------------------------- 

Song Title                          Artist 
                                    Difficulties 

Boom Boom Dollar                    King Kong & D. Jungle Girls 
                                    B/ 2  A/ 5  M/ 6  D/ 3  AD/ 5 

Bad Girls                           Juliet Roberts 
                                    B/ 2  A/ 4  M/ 5  D/ 3  AD/ 4 

Boys                                Smile.dk 
                                    B/ 3  A/ 4  M/ 7  D/ 4  AD/ 5 

Smoke                               Mr. Ed Jumps the Gun 
                                    B/ 3  A/ 4  M/ 6  D/ 4  AD/ 5 

Hero                                Papaya 
                                    B/ 4  A/ 5  M/ 6  D/ 5  AD/ 6 

Dub I Dub                           Me & My 
                                    B/ 4  A/ 6  M/ 8  D/ 5  AD/ 7 

Stomp to My Beat                    JS16 
                                    B/ 5  A/ 6  M/ 7  D/ 5  AD/ 6 

Get Up 'N Move                      S&K 
                                    B/ 5  A/ 7  M/ 8  D/ 6  AD/ 7 

If You Were Here                    Jennifer 
                                    B/ 5  A/ 6  M/ 7  D/ 6  AD/ 7 

I Believe in Miracles               Hi-Rise 



                                    B/ 5  A/ 6  M/ 8  D/ 6  AD/ 7 

Love                                Sonic Dream 
                                    B/ 3  A/ 5  M/ 7  D/ 3  AD/ 5 

Tubthumping                         Chumbawamba 
                                    B/ 4  A/ 5  M/ 6  D/ 4  AD/ 6 

El Ritmo Tropical                   Dixies Gang 
                                    B/ 2  A/ 6  M/ 7  D/ 4  AD/ 5 

Paranoia                            180 
                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

Paranoia MAX ~dirty mix~            190 
                                    B/ 6  A/ 8  M/ 8  D/ 7  AD/ 8 

Paranoia KCET ~clean mix~           2MB 
                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

Trip Machine                        De-Sire 
                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

SP-Trip Machine ~Jungle Mix~        De-Sire 
                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

Make it Better                      mitsu-O! 
                                    B/ 4  A/ 5  M/ 7  D/ 5  AD/ 7 

Make it Better (So-Real Mix)        mitsu-O! Summer 
                                    B/ 5  A/ 6  M/ 8  D/ 5  AD/ 7 

Make a Jam!                         U1 
                                    B/ 3  A/ 5  M/ 7  D/ 3  AD/ 5 

Put Your Faith in Me                Uzi-Lay 
                                    B/ 3  A/ 4  M/ 6  D/ 4  AD/ 5 

Put Your Faith in Me (Jazzy Groove) Uzi-Lay 
                                    B/ 4  A/ 5  M/ 6  D/ 5  AD/ 6 

Brilliant 2U                        Naoki 
                                    B/ 4  A/ 5  M/ 6  D/ 4  AD/ 5 

Brilliant 2U (Orchestra-Groove)     Naoki 
                                    B/ 5  A/ 6  M/ 7  D/ 4  AD/ 5 

AM-3P                               kTz 
                                    B/ 5  A/ 6  M/ 8  D/ 5  AD/ 6 

Step Battle #1  Keep on Movin'      N.M.R. 
                                    B/ ?  A/ ?  M/ ?  D/ ?  AD/ ? 

Step Battle #2  Let Them Move       N.M.R. 
                                    B/ ?  A/ ?  M/ ?  D/ ?  AD/ ? 

Step Battle #3  20, November        N.M.R. feat. DJ Nagureo 
                                    B/ ?  A/ ?  M/ ?  D/ ?  AD/ ? 

Trip Machine ~luv mix~              2MB 



                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

Think ya Better D                   sAmi 
                                    B/ 3  A/ 4  M/ 5  D/ 3  AD/ 4 

Love This Feelin'                   Chang Ma 
                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

Keep on Movin'                      N.M.R. 
                                    B/ 3  A/ 4  M/ 5  D/ 3  AD/ 4 

Let Them Move                       N.M.R. 
                                    B/ 1  A/ 2  M/ 4  D/ 2  AD/ 3 

20, November -DDR Version-          N.M.R. feat. DJ Nagureo 
                                    B/ 1  A/ 3  M/ 4  D/ 2  AD/ 4 

Paranoia MAX in Roulette            190 
                                    B/ 6  A/ 7  M/ 8  D/ 7  AD/ 8 

4.1 Bonus Track 
-------------------------------------- 

    When you press the button to begin this mode (from the main menu) you will  
automatically be able to choose your "Play Option" (no special command is  
required as was in "Arcade" mode). You can also choose your level variant and  
effects from the "Effects Menu," which is accessed in the same manner as it was  
in "Arcade" mode. After you play each stage, you will be prompted to "Press 'O'  
to continue playing, or 'X' to exit." The "Bonus Tracks" are additional songs  
that are previews of things to come (in this case, they are songs from DDR 3rd  
Mix). In this game, however, you can only play these songs on "Basic" or  
"Double" variant. They will show up as "Trial" variant when you open the Effects  
Menu. Additionally, there is no spot in the "Records" list for your scores on  
these tracks. However, you can still play these songs in "Training," "Edit," and  
"Non Stop Revolution" modes. The bonus songs are as follows: 

Song Title                          Artist 
                                    Difficulties 

In the Navy '99                     Captain Jack 
                                    B/ 4  A/ X  M/ X  D/ 4  AD/ X 

The Race                            Captain Jack 
                                    B/ 3  A/ X  M/ X  D/ 3  AD/ X 

4.2 Extra Track 
-------------------------------------- 

    This mode appears as an alternate mode in the same spot as "Bonus Track." To  
make it appear, press the "select" button at the title screen's main menu. This  
will cause the words "Extra Track" to replace "Bonus Track" (you can reverse  
this process by pressing "select" again). See the tricks section to find out how  
to access this ability. Anyhow, this is the same song that you play during the  
secret "Ending" for "2nd ReMIX." By default, you will play the "one-player"  



version of this level. To play the "two-player" version of this level, you must  
hold down the "X" button while you press a button to select Extra Track at the  
title screen's main menu. 

5.0 Training Mode 
-------------------------------------- 

    "Training" mode is the place to sharpen your skills on any level that you  
have accessed, without fear of losing. At any time during the menu, you may  
press the "select" button to move the menu to the other side of the screen. And,  
after each level you play, you get a choice of "Press 'O' for menu, or 'X' to  
exit." In the menu, you can choose from: "Check/Again/Return." The "Check"  
option lets you review the song you just played, bar by bar, and shows you how  
well you did for each step (arrow-press) in the level. Each arrow will be  
colored in a specific shade to indicate how each was ranked (yellow=perfect,  
green=great, blue=good, pink=boo, red=miss). "Again" lets you repeat the level,  
and "Return" takes you back to the main menu. The menu options are as follows: 

    -Music Select 

    -Player: Single/Couple/Versus/Double 

    -Level: Basic/Another/Maniac 

    -Little: On/Off 

    -Turn: Left/Right/Mirror/Shuffle/Off 

    -Hidden: On/Off 

    -Speed: 1-5 

    -Bar Start: 01-70 

    -Bar End: 02-71 

    -Edit 

    -Start

    -Exit 

6.0 Records List 
-------------------------------------- 

    This menu keeps a list of your high scores for all of the game's stages  
(Music High Score). You can view high scores for each variant of each song (five  
variants per song). It keeps track of your letter and number high score for each  
one, as well as your maximum combo achieved while earning that score. In this  
game, your highest overall scores (Total Ranking) may be viewed during the "demo  
reel" that runs from the main menu (whenever a button is not being pressed). At  
any time during the below menus, you may press the "select" button to "change"  
the pictures to plain text. On Endless, pressing "left" or "right" on the  
directional pad will switch between "Stage Ranking" and "Score Ranking." The  
menu options are as follows: 



    -2nd ReMIX 

    -Endless 
        -Stage Ranking 
        -Score Ranking 

    -Exit 

7.0 Edit Mode 
-------------------------------------- 

    This mode is one of the cooler features of the game, as it lets you create  
your own sets of steps for any of the game's levels. From here, you create your  
steps and then save them to a memory card. At any time in the process, if you  
attempt to start a "new data" or "load" data without having "saved" your current  
data, the game will ask you "Do you wish to continue without saving: Yes/No."  
The menu options are as follows: 

    -New Data 
        -Choose Song 
        -Player: Single/Couple/Double 
        -Load Official Data: Yes/No 
            -Basic/Another/Maniac 

        -Directionl Pad: move one beat distance up/down 
        -Circle: create/delete right arrow 
        -Triangle: create/delete up arrow 
        -X button: create/delete down arrow 
        -Square: create/delete left arrow 
        -L1: change beat distance (Full/Half/Fourth) 
        -R1: hold down and press up/down to move in full bars 
        -L2: create an area (press once for start, once for end) 
        -R2: clear line 
        -Select: change measurement (Bar/Sec) 
        -Start: Area Menu (effects contents of created area) 
            -Copy 
            -Paste 
            -Cut 
            -Delete 
            -Exit 

    -Memory Card 
        -Save 
        -Load 
        -Rename 
        -Convert 
        -Exit 

    -Player 
        -Single/Couple/Double 

    -Test Play 
        -Start: 01-70 
        -End: 02-71 

    -Guide

    -Exit 



7.1 Paint Mode 
-------------------------------------- 

    This mode appears as an alternate mode in the same spot as "Edit Mode." To  
make it appear, press the "select" button at the title screen's main menu. This  
will cause the words "Paint Mode" to replace "Edit Mode" (you can reverse this  
process by pressing "select" again). See the tricks section to find out how to  
access this ability. Anyhow, this is another of the game's more creative modes.  
In here, you can draw and paint an icon-sized image to use in the game modes "in  
place of the step arrows." Yes, this means that the data you save in here can be  
used in place of the up, down, left, and right arrows. These arrows that you  
draw can be ported over to DDR 3rd Mix by using the "Link Version." By pressing  
the "select" button at any time you are in the main menus, you will bring up the  
"Guide" menu. On the top of this screen is a set of Eight "storage slots" in  
which you can save your different custom arrows (Four for Player 1, and Four for  
Player 2). In the lower-right corner is the color chart (colors: 1-13) and the  
X-Y coordinates of the cursor. At any time in the process, if you attempt to  
"exit" Paint mode without having "saved" your current data, the game will ask  
you "Do you wish to continue without saving: Yes/No." The menu options are as  
follows: 

    -Draw Mode 
        -Directionl Pad: move cursor 
        -Circle: draw one sigle pixel 
        -Triangle: draw a four-pixel box 
        -X button: erase one single pixel 
        -Square: set color to number "0" 
        -L1: previous color 
        -R1: next color 
        -L2: standard arrow color 
        -R2: custom arrow effects (Rainbow/Blink/Off) 
        -Select: Guide 
        -Start: Main Menu 

    -Grid: On/Off 

    -Displace Image 
        -Hold "circle" button, move with directional pad 

    -Rotate image 180 degrees 

    -Rotate image 90 degrees (clockwise) 

    -Use preset image 
        -Dred 
        -Janet 
        -Afro 
        -Lady 
        -Bunny 
        -Plug 
        -Arrow 
        -White Background 

    -Clear image 

    -Set image (in storage slots) 



    -Get image (from storage slots) 

    -Save 

    -Load 

    -Exit 

8.0 Event Mode 
-------------------------------------- 

    When you press the button to begin this mode (from the main menu) you will  
automatically be able to choose your "Play Option" (no special command is  
required as was in "Arcade" mode). In "Event Mode," you can play any of the  
game's songs as many times as you wish. Additionally, you will not lose a stage  
when your dance meter is empty (as with "Easy" difficulty). You can also choose  
your level variant and effects from the "Effects Menu," which is accessed in the  
same manner as it was in Arcade mode. After you play each stage, you will be  
prompted to "Press 'O' to continue playing, or 'X' to exit." 

8.1 Non Stop Order 
-------------------------------------- 

    You use this mode to create the custom sets of levels for use in "Non Stop  
Revolution." By pressing the "select" button at any time you are in the main  
menus, you will bring up the "Guide" menu. You can set up and customize up to  
Three different sets of Five levels. These levels can be fully customized as  
well. And better yet, each of the Five stages can have a totally different set  
of difficulty, variant, and effects than the rest. The menu options are as  
follows: 

    -2nd ReMIX: [1]/[2]/[3] 
        -1st Stage 
            -Edit: Title/NoUse 
            -Music: Select Music 
            -Player 1 
                -Level: Basic/Another/Maniac 
                -Little: Little/Off 
                -Turn: Left/Right/Mirror/Shuffle/Off 
                -Hidden: Hidden/Off 
            -Player 2 
                -Same options as with Player 1 
        -2nd Stage 
            -Same options as with 1st Stage 
        -3rd Stage 
            -Same options as with 1st Stage 
        -4th Stage 
            -Same options as with 1st Stage 
        -5th Stage 
            -Same options as with 1st Stage 

    -3rd Mix: [1]/[2]/[3] 
        -Same options as with 2nd ReMIX 

    -Exit 



8.2 Non Stop Revolution 
-------------------------------------- 

    When you press the button to begin this mode (from the main menu) you will  
automatically be able to choose your "Play Option" (no special command is  
required as was in Arcade mode). This mode uses the data that you create with  
"Non Stop Order." On the bottom of the main menu, it will list the Five songs  
that are contained within whichever data set you currently have selected. The  
menu options are as follows: 

    -Order Option: [1]/[2]/[3] 

8.3 Endless Mode 
-------------------------------------- 

    This mode lives up to its name, as it can tend to last forever. You play a  
constant streak of levels, randomly chosen, until your dance meter empties and  
you lose (you will not repeat any songs until you have played each song once,  
and then it starts another random loop). However, you will get a "Break" after  
every Five levels you play. It will ask you "Take a Break?" and give you choices  
of: "1 Minute/3 Minutes/5 Minutes/Continue." You have Ten seconds to decide  
whether you take a Break or you continue playing. You can end a Break at any  
time by pressing the "start" button. During gameplay, your "combo" can carry  
over from one stage to another (so your combo can go up to any number, not just  
up to 999 like usual). Your score and stage can also go on infinitely, only  
limited by how long you can make yourself play. In the lower-right corner of the  
menu is the highest "Score," "Stage," and "Combo" you have been able to reach in  
Endless mode. The menu options are as follows: 

    -Player: Single/Double/Random 

    -Level: Basic/Another/Maniac/Random 

    -Turn: Left/Right/Mirror/Shuffle/Random/Off 

    -Hidden: On/Random/Off 

    -Little: On/Random/Off 

    -Bright: 25%/50%/75%/100% 

    -Start

    -Exit 

9.0 Information Screen 
-------------------------------------- 

    This screen keeps track of how far you've progressed in the overall game.  
The first pieces of info on this screen are of general information or about new  
features that are present in this version of DDR. Whenever you earn a secret  
song or mode, you will get some new pieces of information on this screen to let  
you know (and describe it). Also, you can get congratulatory messages for  
fulfilling certain goals. In the upper-right corner of the menu, you can see how  



many total information pages you have earned (you start out with about Four, but  
will end up with over Fifty). 

10.0 Disc Change 
-------------------------------------- 

    With this command, you will be able to switch to another DDR disc. There are  
various "Append Discs" that are add-ons to this particular DDR game (though they  
are played separately, and have separate data, you can not play them unless you  
go through this menu). Also, there are various features to be accessed when you  
change to another full DDR game. When you enter this mode, you will be prompted  
to "Insert Disc and press 'start.'" The Append Discs (and special features for  
full discs) are as follows: 

    -Dance Dance Revolution 
        -Play Event Mode (original stages) with setup from 2ndRemix 
    -DDR 2nd Remix: Append Club Version Vol. 1 
    -DDR 2nd Remix: Append Club Version Vol. 2 

11.0 Game Secrets and Hidden Options 
-------------------------------------- 

    -Experience. Whenever you complete a stage in the game, it will add (or  
subtract) a certain number of "experience points" from your overall amount. The  
game keeps track of these internally, and you can not view your points at any  
time. Additionally, the game keeps track of how many "footmarks" you have  
accumulated. What this means, is that the "difficulty level" number from each  
level you play (in range from 1-8) is added to the total amount of footmarks.  
And, to note, the difficulty level (footmark number) of each stage you complete,  
along with the "variant" level of that stage, will determine how many experience  
points are earned for it. The purpose of these experience points and footmarks  
is to earn various "secret songs" and "special modes." When playing modes other  
than standard "Arcade," the amount of experience gained will be multiplied by a  
various value (listed under the table below). The experience gained when playing  
is as follows: 

                               Number of Footmarks Played 
  Game Mode               1    2    3    4    5    6    7    8 

  Basic                   100  70   50   20   15   10   7    3 
  Another/Basic Double    20   10   5    0   -5   -10  -20  -40 
  Maniac/Another Double  -20  -40  -60  -80  -100 -120 -170 -200 

        -Easy Mode 
            -Positive experience: multiplied by 1.2 
            -Negative experience: multiplied by 0.8 
        -All Music Mode 
            -Positive experience: multiplied by 0.9 
            -Negative experience: multiplied by 0.6 
        -Two Player Mode 
            -Both players get the higher experience of the two 
        -Event Mode 
            -No experience is added 



    -Special Levels. When you first have access to "All Music Mode" or "Event  
Mode" you will be unable to play the "special levels" on them (do not confuse  
these with the "secret songs"). These levels are as follows, and must be played  
the proper amount of times in "Arcade" mode before they can be played in these  
above modes: 

        -Step Battle: play Step Battle more than 10 times 
        -Random Disc: play Random Disc more than 20 times 

    -Special Options. Some choices in the game's main "Option" menu are not  
accessible from the start. They get unlocked at various points in your playing  
experience. The Ending option for "2nd ReMIX" becomes avavilable once you open  
up "Think ya Better D." The character option for "Model 3 and 4" becomes  
available once you open up "Event Mode." 

    -Effects. In this game, you can not choose the level "effects" by default  
(see above for what they are). When you play any standard game mode, and are  
choosing your next stage to play, you can access the "Effects Menu." This menu  
starts out empty, and you must input the following codes (on the directional  
pad, while in the special menu) to fill it in with these choices. The  
"Information Screen" will tell you about these codes at various points in your  
playing experience, but they can be done from the start anyhow: 

        -Little:   L, D, R, D, L, D, R, D, U 
        -Left:     L, L, L, L, L, L, L, L 
        -Right:    R, R, R, R, R, R, R, R 
        -Mirror:   L, R, L, R, L, R, L, R 
        -Shuffle:  U, D, L, R, D, U, R, L 
        -Hidden:   U, D, U, D, U, D, U, D 

    -Secret Songs. Some of the game's songs will not be accessible from the  
start of the game. You must fulfill a certain requirement in order to unlock  
each of them. Some of the stages will have different methods to unlock them. As  
long as you fulfill one of these requirements, you do not need to fulfill the  
rest in order to access it. Once you do so, they will be available to play at  
any time in their respective modes and stages: 

        -20, November -DDR Version- 
            -clear Normal mode 1 time 

        -Keep on Movin' 
            -clear Hard mode 5 times 

        -Think ya Better D 
            -clear more than 50 stages 
            -footmarks are less than 150, clear more than 30 stages 

        -Trip Machine ~luv mix~ 
            -clear more than 100 stages 
            -clear one "other" version of Trip Machine 30 times 
            -set a record for all variants of both those "others" 
            -experience is more than 3000 or less than -10000 

        -Love This Feelin' 
            -clear more than 200 stages 
            -clear more than 150 "Konami Original Remix" stages 
            -experience is more than 5000 or less than -15000 

    -All Music Mode. When you select the difficulty level in "Arcade" mode,  
highlight the option for "Hard," and then press "right" four times on the  



directional pad. Each time you press it, a small arrow will disappear from over  
the Hard circle. When the words "All Music" appear, hit the button and begin the  
game. In this mode, you will play a default of Three stages (same setting and  
style as Hard mode is set to). You can play any song in the game for any of the  
Three stages, and you can even repeat the same song if you want (though the  
"secret songs" will not be available until they are unlocked elsewhere). 

    -Super Mode. This mode is activated from the title screen's main menu. When  
you input the following command on the directional pad, you will turn the mode  
on (and you can do it again to turn it off): U, U, D, D, L, R, L, R . When it is  
active, the title screen will change from Blue to Red in background color. This  
only makes one minor change to the game, which is to lessen the amount of dance  
moves that the characters perform on screen. Every other aspect of the game is  
totally unchanged. This mode is used if you wish to reduce the amount of loading  
time between menus and stages. The "Information Screen" will tell you about this  
code at a various point in your playing experience, but it can be done from the  
start anyhow. 

    -Paint Mode. This mode is not accessible from the start of the game. To open  
it up, you must meet one of the following requirements. As long as you fulfill  
one of these requirements, you do not need to fulfill the rest in order to  
access it:

        -play DDR 3rd Mix (Arcade) with your memory card data 
        -set the game options to the following settings, then 
         at the title screen's main menu, press on directional 
         pad: R, L, R, L, D, D, U, U 
            -Game Level: 7 
            -Max Stage: Easy 5, Normal 3, Hard 1 
            -Time Limit: On 
            -Game Over: 2nd ReMIX 
            -Character: Model 2 

    -Extra Track. This mode is not accessible from the start of the game. To  
open it up, you must get an "SS" score when you play the special "Ending" for  
"2nd ReMIX" at the end of "Arcade" mode (get a "Perfect" or "Great" for every  
step). You will hear a special sound at the end of the game's Ending if you got  
the "SS" score. From this point on, you can access the Extra Track. 

    -Event Mode. This mode is not accessible from the start of the game. To open  
it up, you must meet one of the following requirements. As long as you fulfill  
one of these requirements, you do not need to fulfill the rest in order to  
access it:

        -clear All Music Mode more than 15 times 
        -use the Disc Change option (and then switch back) 

    -Non Stop Order and Revolution. This mode is not accessible from the start  
of the game. To open it up, you must meet one of the following requirements. As  
long as you fulfill one of these requirements, you do not need to fulfill the  
rest in order to access it: 

        -clear Normal mode more than 50 times 
        -clear Hard mode more than 200 times 
        -footmarks are more than 200, clear Normal mode 30 times 
        -footmarks are less than 120, clear Normal mode 30 times 

    -Endless Mode. This mode is not accessible from the start of the game. To  
open it up, you must meet all of the following requirements. Once they are all  
fulfilled, complete the Arcade mode once to open up Endless mode: 



        -open up all the Secret Songs 
        -open up Event Mode 
        -open up Non Stop Order and Revolution 

    -Select Characters. There are more characters to play as in this game (other  
than the primary man and woman character). Both Player 1 and Player 2 have Three  
different character models for Arcade mode (or any other mode where you can view  
a character). By holding either "left" or "right" on the directional pad, and  
then pressing the button to select Arcade mode (or the other modes) you will  
select the alternate character models. By pressing the button without holding  
either direction ("neutral" on the directional pad) you will get the standard  
character for that mode. Additionally, there are Four different "Model Sets"  
that you can choose in the game's "Options Menu." The characters you can select  
are as follows: 

         Mode              Left         Neutral       Right 

        -Model 1 P1   :    Plug 2       Dred          Afro 3 
        -Model 1 P2   :    Bunny 2      Janet         Lady 
        -Model 2 P1   :    Alien        Dred 2        Afro 4 
        -Model 2 P2   :    Cow          Janet 2       Lady 2 
        -Model 3 P1   :    Plug         Afro          Mars 
        -Model 3 P2   :    Bunny        Girl          Venus 
        -Model 4 P1   :    Bug          Afro 2        Exclaim 
        -Model 4 P2   :    Cat          Girl 2        Question 

    -Link Version. When you save your data to the memory card, you can then use  
your memory card for the Arcade version of DDR 3rd Mix. This compatible machine,  
the "Link Version," has a slot for the Playstation memory card on it. One of the  
modes you can port over to the 3rd Mix Arcade is the "Paint Mode" data.  
Additionally, the "Non Stop Revolution" is compatible with DDR 3rd Mix. 

12.0 Contributions and Thank-You's 
-------------------------------------- 

    An extra-special thanks goes out to the DDRers' Stompin' Ground. Their site  
provided me with the info on the "experience points" and "footmark total" that  
are calculated to earn various secret songs and modes. Their site is a very  
incredible source of information, and everyone should check it out. You can find  
info on the home or arcade games, as well as a terrific message board. They can  
also keep you up-to-date on the latest releases in the DDR world. I thank them  
very much, and suggest that everyone check them out. 

    GameFAQs (www.gamefaqs.com) for hosting this FAQ, along with more great  
gaming info than most any site out there. Keep up the good work, man. Without  
GameFAQs... where would we all go for detailed game help? Sure, lotsa places  
have great code archives, and some TRY to keep all the best FAQs. But who  
succeeds? Only one, my friend ^_^ Jeff "CJayC" Veasey does an astounding, daily  
job of organizing these entries (and he writes his own wonderful FAQs). I must  
also give a hearty thanks to Al Amaloo, the maintainer of Videogame Strategies  
(vgstrategies.about.com). He has completed perhaps the best and most extensive  
archive of codes and tricks (www.gamewinners.com) and written extensive guides  
for games that would go otherwise un-covered. And what makes these two men (Jeff  
Veasey and Al Amaloo) so special... is that they provide an invaluable service  
to the gaming community out of the goodness of their heart. They work hard,  



every day, without the help of any major affiliate. Bravo to both of you! 

    The wonderful patrons of my own message board, the OtherWorlds Shrine  
(www.tows.org) which is sometimes the only refuge for the true gamer. Along with  
my friend SineSwiper, we keep the shrine alive as a place for gamers to  
respectfully speak and get together while online. The friends that I have made  
there have meant the world to me, despite how my "real life" sometimes drags me  
offline for days at a time. Either way, here's to ya'll... and I won't mention  
any names (as there are too many of you to possibly remember them all now. And  
you'll kill me if I miss any, hehe). The place has been around for years, and I  
guarantee that it will always exist as long as there is an Internet. 

    The select few of my real-life friends who love gaming almost as much as  
myself, and keep me inspired to keep on playing. Tacchi, you're as obsessed over  
games as me. We've been gaming for well near two decades. We're getting old,  
dude. And Crystal, well you can kick most of our sorry arses ^_^ Steffannee...  
you introduced me to Will in Rival Schools! Scott, you've been a pal through it  
all, despite how you suck at games ^_^ Kathryn, your love and understanding will  
always be cherished (yes, call me sappy). And Alex, you've been there since we  
were infants, when the NES was only a dream in the semi-near future. Chris,  
you're one of my dearest friends (as well as one of the most eerily unique).  
Your love for the Butterfly song and the goofy dance you do... will always bring  
a smile to my face. 

    And of course, thanks go out to Lynn and Donna! You two are a few of the  
only people who love Pop 'n Music (and Bust a Move of course) as much as I do.  
Every time we meet is a cherished moment. And, speaking of music games, I owe a  
world of thanks to Malcolm. His friendship has meant a ton to me, and he's one  
of those few folks who plays and works hard at ALL the music game series just  
like I do (Beatmania, Dance Dance Revolution, Pop 'n Music, Bust a Move, and the  
countless other Bemani titles as well). Matt, you're the only true Gas-o, and a  
dear dear friend (I know, I use that phrase so often, but it's true!) And  
finally, Freddy-kun, you love H-anime more than any other Shorty I've ever known  
^_^;;

    Konami, Sony, Sega, and all the great companies and people who made the game  
possible. Without them, we'd never have been introduced to this wonderous world,  
beautiful characters, and a style of gaming that changed our lives. These Bemani  
games, like Dance Dance Revolution, are perhaps my favorite genre out there  
right now. It gives those folks with a "rhythmical sense" a way to convey that  
sense through gaming. And besides, it beats having another cookie-cutter RPG or  
fighter to deal with. 
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